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About This Guide

Purpose
This manual provides an overview of the Agent Greeting and Whisper Announcement feature, and 
describes how to configure and use these features.

Audience
This manual is for supervisors and agents who want to use the Agent Greeting and Whisper 
Announcement features with the Cisco Contact Center software.

Organization
The manual is divided into the following chapters.

Chapter Description

Chapter 1, “About Agent 
Greeting”

This chapter provides an overview of Agent 
Greeting.

Chapter 2, “How Agent 
Greeting Works”

This chapter describes how Agent Greeting 
works.

Chapter 3, “How to Deploy 
and Configure Agent 
Greeting”

This chapter includes information about how to 
deploy and configure Agent Greeting.

Chapter 4, “Using Agent 
Greeting with Your CTI OS 
Agent or Supervisor 
Desktop”

This chapter includes information about how to 
use Agent Greeting with CTI OS and supervisor 
desktop.

Chapter 5, “Using Agent 
Greeting with Your CAD 
Agent or Supervisor 
Desktop”

This chapter includes information about how to 
use Agent Greeting with CAD and supervisor 
desktop

Chapter 6, “Agent Greeting in 
a Parent/Child Deployment”

This chapter describes how to use Agent 
Greeting in a Parent/Child deployment.
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  Related Documentation

Related Documentation
Documentation for Cisco Unified ICM/Unified Contact Center Enterprise & Hosted (United 
ICM/CCE/CCH), as well as related documentation, is accessible from Cisco.com at 
http://www.cisco.com/cisco/web/psa/default.html?mode=prod.

• Related documentation includes the documentation sets for Cisco CTI Object Server (CTI OS), 
Cisco Agent Desktop (CAD), Cisco Agent Desktop - Browser Edition (CAD-BE), Cisco Unified 
Contact Center Management Portal, Cisco Unified Customer Voice Portal (Unified CVP), Cisco 
Unified IP IVR, Cisco Support Tools, and Cisco Remote Monitoring Suite (RMS).

• For documentation for these Cisco Unified Contact Center Products, go to
http://www.cisco.com/cisco/web/psa/default.html?mode=prod 
click on Voice and Unified Communications, then click on Cisco Unified Contact Center 
Products or Cisco Unified Voice Self-Service Products, then click on the product/option you are 
interested in.

• For troubleshooting tips for these Cisco Unified Contact Center Products, go to 
http://docwiki.cisco.com/wiki/category:Troubleshooting, then click the product/option you are 
interested in.

• Also related is the documentation for Cisco Unified Communications Manager, which can also be 
accessed from http://www.cisco.com/cisco/web/psa/default.html?mode=prod

• Technical Support documentation and tools can be accessed from 
http://www.cisco.com/en/US/support/index.html

• The Product Alert tool can be accessed through (login required) 
http://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice

Conventions
This manual uses the following conventions.

Chapter 7, “Troubleshooting 
Agent Greeting”

This chapter includes troubleshooting tips and 
frequently asked questions.

Chapter 8, “About Whisper 
Announcement”

This chapter provides an overview of Whisper 
Announcement.

Chapter 9, “How Whisper 
Announcement Works”

This chapter describes how Whisper 
Announcement works.

Chapter 10, “How to Deploy 
and Configure Whisper 
Announcement”

This chapter includes information about how to 
deploy and configure Whisper Announcement.

Chapter 11, “Whisper 
Announcement in a 
Parent/Child Deployment”

This chapter describes how to use Whisper 
Announcement in a Parent/Child deployment.

Chapter 12, “Related 
Information”

This chapter includes related information.

Chapter Description

http://www.cisco.com/cisco/web/psa/default.html?mode=prod
http://www.cisco.com/cisco/web/psa/default.html?mode=prod
http://www.cisco.com/cisco/web/psa/default.html?mode=prod
http://www.cisco.com/en/US/support/index.html
http://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice
http://docwiki.cisco.com/wiki/category:Troubleshooting
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Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional

information, see the monthly What's New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) 
feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds 
are a free service and Cisco currently supports RSS version 2.0.

Documentation Feedback
You can provide comments about this document by sending e-mail to the following address:

mailto:ccbu_docfeedback@cisco.com

We appreciate your comments.

Format Example

Boldface type is used for user 
entries, keys, buttons, and folder 
and submenu names.

Choose Edit > Find from the ICM 
Configure menu bar. 

Italic type indicates one of the 
following:

• A newly introduced term

• For emphasis

• A generic syntax item that 
you must replace with a 
specific value

• A title of a publication

• A skill group is a collection of agents 
who share similar skills.

• Do not use the numerical naming 
convention that is used in the 
predefined templates (for example, 
persvc01).

• IF (condition, true-value, false-value)

• For more information, see the 
Database Schema Guide for Cisco 
Unified ICM/Contact Center 
Enterprise & Hosted. 

An arrow (>) indicates an item 
from a pull-down menu.

The Save command from the File menu is 
referenced as File > Save.

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
mailto:ccbu_docfeedback@cisco.com
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1
About Agent Greeting

The Agent Greeting feature lets you record a message that plays automatically to callers when they connect 
to you. Your greeting message can welcome the caller, identify yourself, and include other useful contextual 
information. With Agent Greeting, each caller can receive a clear, well-paced, language-appropriate, and 
enthusiastic introduction. And it saves you, the agent, from having to repeat the same introductory phrase for 
each call. It also gives you a moment to review your desktop software screen pop while the greeting plays.

The process of recording a greeting is much the same as recording a message for your voice mail. Depending 
on how your call center is set up, you may be able to record different greetings that play for different types 
of callers (for example, an English greeting for English speakers or an Italian greeting for Italian speakers).

By default, greeting play is enabled when you log in to your agent desktop but you can turn it off and on 
as necessary.

System Requirements and Functional Limitations
To use Agent Greeting, your system must meet these baseline requirements.
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Software Requirements
These software pieces must be in place to deploy Agent Greeting.

What Requirement

Unified CCE Software 
Versions 

To use Agent Greeting, your Unified CCE deployment must be 
running:

• Unified ICME 8.5(1) or later

• Unified CVP 8.5(1) or later 

• Unified CTI OS 8.5(1) or later

• Unified CM 8.5(1) or later

Deployment Models Agent Greeting is supported with Enterprise deployments of Unified 
CCE with CVP only; it is not supported with hosted deployment 
models or with Unified IP IVR.

Agent Greeting in Parent/Child deployments and Agent Greeting for 
mobile agents both require Unified CCE, Release 8.5(2) or later.

Agent Greeting for Parent/Child is only supported for a very specific 
Parent/Child configuration, where calls are queued at a CCX (IP-IVR) 
on the child system PG, and requires a dedicated CVP at the child on 
a dedicated VRU PG to provide the agent greetings. Agent Greeting 
in Parent/Child configurations must be approved by the Cisco 
Assessment to Quality (A2Q) process and require Cisco Design 
Mentoring Service to assure that the deployment model is designed 
and sized correctly to support the Agent Greeting feature.



1-3
Agent Greeting and Whisper Announcement Feature Guide for Cisco Unified Contact Center Enterprise

Release 8.5(x)

Chapter 1      About Agent Greeting
  System Requirements and Functional Limitations

Protocol Requirements
These protocol and encoding pieces must be in place to deploy Agent Greeting.

Agent Greeting Phone Requirements (for local agents only)
Agent Greeting is available to agents and supervisors who use IP Phones with Built-in-Bridge that are 
controlled by the Unified CCE and Unified Communications Manager. These agents are typically 
located within a contact center. Phones used with Agent Greeting must meet these requirements:

• The phones must have the Built-in-Bridge (BiB) feature.

Note Agent Greeting is not supported if you disable the BiB feature. If you disable BiB, Unified CCE 
attempts to use a conference bridge for agent greeting call flow and a warning event is raised.

Agent Types Agent Greeting is supported for blended outbound agents when they 
receive inbound calls.

Agent Desktops Agent Greeting is supported with CTI OS desktops created using the 
COM or C++ CILs. CTI OS includes Active X controls that let you 
integrate Agent Greeting buttons (Enable/Disable Greeting, Record 
Greeting) into the desktop. For more information, see the CTI OS 
developer documentation.

Agent Greeting is supported with CAD, VB, Java, and .NET desktops 
with these limitations:

• There is no support for Agent Greeting controls in the desktop.

• Agents cannot enable or disable the feature. For more information 
about CAD, see the section on using Agent Greeting with CAD.

• Greeting recording calls made using CTI OS are assigned the 
Peripheral Call Type value 40. 
(AGENT_GREETING_RECORDING). Greeting recording calls 
made using CAD, VB, Java, or .NET are assigned the Peripheral 
Call Type value 10 (AGENT_INSIDE).

• PG capacity is reduced (CAD only).

Note For more information about Agent Greeting with CAD, see 
Chapter 5, “Using Agent Greeting with Your CAD Agent or 
Supervisor Desktop.”

What Requirement

What Requirement

CVP Call Control Protocols Agent Greeting is supported with SIP as the CVP call control protocol. 
H.323 is not supported. 

Codecs Agent Greetings are recorded using G.711 encoding. CVP supports a 
mixed codec environment in which the IVR uses G.711 encoding while 
customer/agent calls can use G.729.  G.722 is not supported. 

http://www.cisco.com/en/US/products/sw/custcosw/ps14/products_programming_reference_guides_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps14/products_programming_reference_guides_list.html
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• The phones must be running the firmware version delivered with Unified CM 8.5(1) or greater. (In 
most cases phone firmware is upgraded automatically when you upgrade your Unified CM 
installation.)

• See the Unified CCE Compatibility Matrix for the list of supported Cisco Unified Call Center phone 
models.

http://www.cisco.com/en/US/products/sw/custcosw/ps1844/products_device_support_tables_list.html
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Configuration Requirements
These configuration pieces must be in place to deploy Agent Greeting.

Where What

Unified CM For phones that use the feature, you must set the Built-in-Bridge option 
to On or Default (if the value of Default is On). To verify, in Unified CM 
Administration select Device > Phone > Built in Bridge. 

Unified ICM Agent Greeting is supported with Type 10 Network VRUs only. (Type 
10 is required to allow CVP to control the call). If your current Unified 
ICME deployment is not configured for a Type 10 VRU, you must 
modify it accordingly. 

Agent Greeting requires at minimum three Extended Call Context 
(ECC) variables. 

• user.microapp.ToExtVXML: This is used twice in an Agent 
Greeting record script: the first time is to queue the CVP 
RecordAgentGreeting application; the second time is to tell the 
recording application where to save greeting files. Ensure this 
variable includes these settings: Maximum Length - 100; Maximum 
Array Size - 4; Enabled.

• user.microapp.app_media_lib: This is required in Agent Greeting 
record and play scripts to specify the dedicated directory on the 
media server where your greeting audio files are stored.* 
user.microapp.input_type: This is required in Agent Greeting record 
scripts to limit the allowable input type to DTMF. 

No other EEC variables are needed provided that you serve your 
files from the CVP default media server, and your files are in the 
media server default locale directory 
("<web_server_root>\en-us\"). However, if you store your files in a 
location other than these defaults, you must use one or more of the 
following ECC variables in your scripts. 

• user.microapp.media_server: Use to identify the CVP media 
server if it is other than the default. 
user.microapp.locale: Use to specify the name of the locale 
directory on the media server if it is other than the default (“en-us”). 

• user.microappUseVXMLParams: Needed in your record script if 
you include the user.microapp.media_server variable. It tells the 
external VXML recording script to use the name/value pair of the 
application that you pass in user.microapp.ToExtVXML. 

To make these variables available to your script authors, confirm 
that they are defined in the Unified CCE Configuration Manager 
tool. See the Configuration and Administration Guide for Unified 
CVP for instructions on defining ECC variables for CVP.

Unified CVP Your CVP installation must include the CVP VXML Server and the CVP 
Call Server. The VXML Server must be deployed and connected to the 
Call Server using the configuration in the CVP Operations Console. 
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Functional Limitations
Agent Greeting is subject to these limitations.

• Agent Greeting is not supported with outbound calls made by an agent. The announcement plays for 
inbound calls only.

• Only one Agent Greeting file plays per call.

• Supervisors cannot listen to agent recorded greetings.

• Agent Greetings do not play when the router selects the agent via a label node.

• Out of the box, the default CTI OS Toolkit Agent desktop includes the Agent Greeting buttons. If 
Agent Greeting is not configured, the Agent Greeting buttons do not execute any functionality. If 
you use the default desktop but do not plan to use Agent Greeting you should remove them.

• Silent Monitoring (CTI OS and Unified CM-based) is supported with Agent Greeting with this 
exception: For Unified-CM based Silent Monitoring, supervisors cannot hear the greetings 
themselves. If a supervisor clicks the Silent Monitor button in their CTI OS desktop while a greeting 
is playing a message displays stating that a greeting is playing and to try again shortly.
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How Agent Greeting Works

This chapter describes how the Agent Greeting feature works.

How Agent Greeting Files Are Played
When an agent answers a customer call, the Agent PIM sends a route request to the router and gets the 
route response back. The Agent PIM tells Unified CM to connect to CVP. When CVP answers the call, 
Unified CM allocates the BiB resource for the agent phone. The router sends CVP a Run Script request. 
In response, CVP tells the VXML gateway to play the requested Agent Greeting media file. The VXML 
gateway plays the media file to the BiB for the phone. Both the agent and customer hear the greeting.

How Agent Greeting Files Are Named and Saved
Agent Greeting files are named automatically at the time an agent records and saves them. The file name 
is a concatenation of the agent sign in name and the current value of the AgentGreetingType variable in 
the Agent Greeting record script.

For example, the sign in name is agent123 and the agent presses 1 to record a greeting. In the Agent 
Greeting record script, when the agent presses 1, the value of the AgentGreeting Type variable is set to 
French. The file is saved as agent123_French.wav

Note Sign in name is the Login Name configured for the agent in the Unified CCE Configuration Manager 
Agent Explorer tool.

How to Limit the Number of Greetings an Agent Can Have
Unified CCE does not impose a limit on the number of concurrent greetings you can allow your agents 
to have. Practically speaking, though, the number of keys on your agents' dial pads sets an upper bound 
of nine. You can further limit the number of greetings in the Network VRU script that prompts agents to 
select the greeting they want to record. For example. in that script, a configuration parameter value of 
1-3 allows three greetings, 1-5 allows 5 greetings, and so on.
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About Login Name Changes and Agent Greeting
The association of the agent with the greeting files is based on Login Name. If an agent Login Name 
changes for any reason, that association is lost and the agent must re-record the greetings. Conversely, 
if a new agent is assigned a pre-existing Login Name, that agent is automatically associated with any 
existing greetings for that name.

Agent Greeting Call Flow 

1 -2. After the agent answers the customer call, the Agent PIM sends a route request to the 
router and gets the route response back.

3. Agent PIM instructs Unified CM to connect to the VRU to add media to the call.

4. Unified CM makes the server call to CVP. After CVP answers the call, Unified CM 
allocates the agent phone's BIB resource.

5 - 12. CVP gets a Run Script request from the router.

13. CVP instructs the VXML gateway to play the agent greeting media file. VXML voice 
gateway plays the media file to Phone's BIB. Agent and customer both hear the greeting.
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Reporting
Greeting time is not specifically broken out in Unified CCE reports. In agent and skill group reports the 
period during which the greeting plays is reported as talk time. Record time is counted as an internal call 
by the default skill group.

Calls that involve Agent Greeting consist of two call legs: the inbound call from the customer and the 
call to CVP for the greeting. Both of these legs have the same RouterCallKeyDay and RouterCallKey 
values in the TCD and RCD tables in the Unified CCE database. You can use these values to link the two 
legs together for reporting purposes.

Greeting Call Statistics
To view greeting call statistics, create a separate call type and associate it with the routing script that 
plays agent greeting. New CUIC templates for the agent greeting call type are created based on the data 
in the existing Call_Type_Real_Time and Call_Type_Interval table in the database.

Peripheral Call Types for Agent Greeting
There are two peripheral call types specific to Agent Greeting that you can use to track and report on the 
feature.

• Call Type 39: Play Agent Greeting. Route request to play an Agent Greeting. 

• Call Type 40: Record Agent Greeting. Agent call for recording an Agent Greeting.

Note Greeting recording calls made using CAD are assigned the Peripheral Call Type value 10 
(AGENT_INSIDE).

Extra TCDs and RCDs are generated for the agent greeting call leg, and they can be linked to the first 
call leg by the same RouterCallKeyDay and RouterCallKey.

Serviceability
Serviceability for Agent Greeting includes system events to indicate reasons for greeting failures and 
counters to track the number of failed greeting events.(Note: There is not a counter for the number of 
failed agent greeting calls.)

Component Failure and Agent Greeting
This sections describes the most common failure types for the Agent Greeting feature.

Failover of ICM and CTI OS Server

In a duplexed deployment, when a router, logger, peripheral gateway, or CTI OS Server fails over, Agent 
Greeting behaves as follows:
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• Logged in agents are automatically logged out and in again. While this is happening, agents see a 
brief message in their desktop client status bar showing that they are being 
disconnected/reconnected. 

• After agents are logged back in, their Agent Greeting state (on or off) is set to what it was prior to 
failover.

Failover of VRU PG

In a duplexed deployment, when a VRU peripheral gateway fails over, Agent Greeting play and record 
may not work until the failover is complete. Agent desktops are unaffected.

Failure to Access CVP Media Server

If the connection to the CVP media server fails, or if a requested greeting audio file cannot be found for 
any reason, the call proceeds normally without the Agent Greeting.

Failure to Access CVP VXML Server

If the VXML Server fails during a greeting recording session the agent experiences a dropped call.

If the Agent Desktop Closes Unexpectedly

If the CTI OS Agent Desktop software closes unexpectedly (for example, due to a crash), when the agent 
relaunches it: A) they remain logged in; B) their Agent Greeting state is set to Enabled.

Using Whisper Announcement with Agent Greeting
You can use Agent Greeting along with the Whisper Announcement feature. Here are some things to 
consider when using them together:

• On the call, the Whisper Announcement always plays first, before the Agent Greeting. 

• To shorten your call-handling time, you may want to use shorter Whisper Announcements and Agent 
Greetings than you might if you were using either feature by itself. A long Whisper Announcement 
followed by a long Agent Greeting equals a long wait before an agent is actively handling a call. 

• If you use a Whisper Announcement, your agents probably handle different types of calls: for 
example, “English-Gold Member-Activate Card,” “English-Gold Member-Report Lost Card,” 
“English-Platinum Member-Account Inquiry.” Therefore, you may want to ensure the greetings your 
agents record are generic enough to cover the range of call types.
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3
How to Deploy and Configure Agent Greeting

This chapter describes how to deploy and configure the Agent Greeting feature.

Agent Greeting Deployment Map
This is the high-level sequence of tasks you need to complete to deploy Agent Greeting. Individual steps 
are covered in more detail in later sections.

1. Ensure your system meets the baseline requirements for software, hardware, and configuration 
described in the System Requirements and Limitations section. See System Requirements and 
Functional Limitations, page 1-1.

2. Configure the media server that serves greeting files. Configuration must be performed on the server 
itself and in CVP. Optionally, you can define a default media server in CVP. See Agent Greeting 
Media Server Configuration, page 3-2 and Using Multiple Media Servers, page 3-4.

3. In CVP, republish to the VXML Gateway.tcl scripts with updated Agent Greeting support. See 
Republishing .tcl Scripts to the VXML Gateway, page 3-4.

4. In CVP, set the cache size on the VXML Gateway to the maximum. See Setting the Cache Size on 
the VXML Gateway, page 3-5.

5. Record the voice prompts to play to agents when they record a greeting. Deploy the audio files to 
your media server. See Creating Voice Prompts for Recording a Greeting, page 3-5.

6. Configure the Call Types and dialed numbers for Agent Greeting record and play. See Configuring 
Dialed Numbers and Call Types for Agent Greeting Record and Play, page 3-6.

7. In the Unified CCE Configuration Manager tool, define the Network VRU Scripts you need for your 
Agent Greeting Scripts. Defining Network VRU Scripts for Agent Greeting, page 3-6.

8. In Unified CCE Script Editor, create the scripts you need for Agent Greeting: 

a. Create a script to record Agent Greetings. See Creating an Agent Greeting Record Script, 
page 3-9.

b. Create a script to play Agent Greetings. Creating an Agent Greeting Play Script, page 3-14.

c. Modify your existing call routing scripts to enable Agent Greeting script. See Modify Call 
Routing Scripts to Use the Play Agent Greeting Script, page 3-15

9. Add the Active X controls for Agent Greeting to your custom C++ or COM-sourced CTI OS agent 
and supervisor desktops. Including the Agent Greeting Controls in Your Agent Desktops, page 3-17
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Note As an alternative to creating scripts from scratch, you can import and modify the example Agent 
Greeting Scripts that are installed on ICM. For more information, see the section on Agent Greeting 
example scripts.

Configuring Your Media Server for Agent Greeting
Your CVP media server is the main storage device for your agent greetings. When a greeting is first 
recorded, it is stored temporarily on the CVP Call Server, where an agent can listen to it prior to 
confirming its use. Once the agent confirms the greeting, the file is transferred to the media server via 
FTP. When a request for the greeting is made (in other words, when the greeting is played to a caller), 
the greeting file is copied from the media server to the VXML Gateway where it is cached. The cached 
copy is used to satisfy subsequent requests for the greeting. Content expires in the cache based on the 
cache timeout period defined on the media server.

Agent Greeting Media Server Configuration
The media servers you use to store and serve your greeting files must meet the following criteria.

Media Server Hardware and Network Requirements

1. Ensure the server is accessible to CVP, Unified CCE, and your agent desktops.

2. See the Unified CVP Hardware and System Software Functional Specification for information about 
Media Server hardware requirements and co-resident software compatibilities.

Media Server Configuration Requirements

1. Ensure that IIS is installed, properly configured, and running on the server. It must be listening on 
port 80.

2. Ensure the server is accessible to CVP, Unified CCE, and your agent desktops.

3. Ensure that FTP is enabled on the server and that Write access is enabled for the FTP Server. This 
allows CVP to copy recorded greeting files to be written to the Media Server. Make note of your 
FTP connection information -- connection type, user name, password, and port number. You must 
enter this information in the CVP Management Console.

4. Make sure that the FTP and the IIS root directory is the same, because the recording application 
writes the file to the media server directory structure, and the greeting playback call uses IIS to fetch 
the file. The “en-us/app” directory should be under the same root directory for FTP and IIS.

5. Create a dedicated directory on the server to store your greeting files. This lets you specify a lower 
cache timeout of 5 minutes for your agent greeting files that does not affect other more static files 
you may be serving from other directories. By default, the Record Greeting application posts the 
.wav file to the en-us/app directory under your web/ftp root directory. You may create a dedicated 
directory such as “ag_gr” under the en-us/app directory, and then indicate this in the Unified CCE 
script that invokes the recording application. Use the array for the ECC variable 
“call.user.microapp.ToExtVXML” to send the ftpPath parameter to the recording application. Make 
sure the ECC variable length is long enough or it may get truncated and fail.

http://www.cisco.com/en/US/docs/voice_ip_comm/cust_contact/contact_center/customer_voice_portal/
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6. In IIS, set the cache expiration for the dedicated directory to a value that allows re-recorded 
greetings to replace their predecessor in a reasonable amount of time, while minimizing requests for 
data to the media server from the VXML Gateway. The ideal value varies depending on the number 
of agents you support and how often they re-record their greetings. Two minutes may be a reasonable 
starting point.

Note After specifying the cache timeout, it is a good idea to clear the cache on the VXML Gateway. This 
ensures the gateway requests the latest files from the media server. You need only clear the gateway 
cache once. Use the gateway “clear HTTP client cache” command.

Note The HTTP client response timeout setting on the gateway must be greater than the time it takes to 
complete the largest anticipated FTP file transfer. If an FTP file transfer takes longer than the configured 
duration in seconds for HTTP client response timeout, the FTP transfer completes correctly, but the call 
drops as soon as the configured timeout duration is met.

How Greeting Files are Recorded and Served

1. An agent initiates a greeting recording session and records a greeting.
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2. The VXML Gateway passes the recorded (but unsaved) greeting file to the VXML Server.

a. The agent asks to listen to the greeting before saving it. The file is played from the VXML 
Server.

3. The agent saves the greeting. The file is named (based on the agent Login Name + 
AgentGreetingType) and stored on the media server.

Requests for the greeting file come in through the VXML Gateway. The VXML Gateway examines its 
web server cache for the file. If the file is present and not expired, the cached version is served. If the 
file is not present, or if its timestamp exceeds the cache expiration, 4. the file is retrieved from the media 
server and cached again.

Configuring the Media Server in CVP

In your CVP Management Console:

1. Add the server to the list of CVP Media Servers (Device Management > Media Server). Ensure that 
you select the FTP Enabled option for the server and configure the credentials and port settings as 
appropriate for the server. These settings tell CVP to write files to the server.

2. Deploy your media servers to your CVP Call Servers (using the Deploy button on the Media Server 
page).

3. Optionally, you can designate one of your media servers as the Default Media Server. If a default 
media server is defined, requests for greeting files are automatically sent to that server without 
having to specify that server in your scripts. Note that if you already deployed the list of media 
servers, you must redeploy it after designating a default.

4. If the initial Unified CCE script overrides the default media server with a SET node, the call context 
of ECC variables is preserved on the greeting playback call as well, and the Default Media Server 
may be overridden. In this case, you may need to modify the greeting playback script to use a SET 
node with the correct media server.

Using Multiple Media Servers
To write greeting files to multiple media servers, set the default media server to act as a proxy. For more 
information, see the CVP documentation.

Republishing .tcl Scripts to the VXML Gateway
The .tcl script files that ship with CVP, Release 8.5(1) include updates to support Agent Greeting. You 
must republish these updated files to your VXML Gateway. Because republishing scripts to the VXML 
Gateways is a standard task in CVP upgrades, this may already have been done. If it has not, you must 
republish the scripts before you can use Agent Greeting.

To republish the scripts:

Step 1 In the CVP Management Console, select Bulk Administration > File Transfer > Scripts and Media.

Step 2 Set Device to Gateway.

Step 3 Select the gateways you want to update. Typically you would select all of them unless you have a specific 
reason not to.

Step 4 Select Default Gateway Files.

http://www.cisco.com/en/US/products/sw/custcosw/ps1006/index.html
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Step 5 Click Update.

Setting the Cache Size on the VXML Gateway
To ensure adequate performance, set the size of the cache on the VXML Gateway to the maximum 
allowed. The maximum size is 100 megabytes; the default is fifteen kilobytes. See the Configuration and 
Administration Guide for Cisco Unified Customer Voice Portal for instructions on how to configure 
caching on the gateway. Failure to set the VXML Gateway cache to its maximum can result in slowed 
performance to increased traffic to the media server.

Creating Voice Prompts for Recording a Greeting
You must create audio files for each of the voice prompts agents hear as they record a greeting. The 
number of prompts you require can vary, but a typical set can consist of:

• A welcome followed by a prompt to select which greeting to work with (this assumes you support 
multiple greetings per agent) 

• A prompt to select whether they want to hear the current version, record a new one, or return to the 
main menu. 

• A prompt to play if a selected greeting is not found.

Create the files using the recording tool of your choice. When you record your files:

• The media files must be in .wav format. Your .wav files must match CVP encoding and format 
requirements (G.711, CCITT A-Law 8 kHz, 8 bit, mono). 

• Test your audio files. Ensure that they are not clipped and that they are consistent in volume and 
tone.

After recording, deploy the files to your CVP media server. Note the names of each file and the location 
where you deploy them on the media server. You script authors need this information for the Agent 
Greeting scripts. The recommended default deployment location is to the <web_server_root>en-us\app 
directory.

Built-In Recording Prompts

The Unified CVP Get Speech micro-application used to record Agent Greetings includes these built-in 
prompts:

• A prompt that lets agents play back what they recorded. 

• A prompt to save the greeting, record it again, or return to the main menu. 

• A prompt confirming the save, with an option to hang up or return to the main menu.

You can replace these .wav files with files of your own. For more information, see the CVP Call Studio 
documentation.

http://www.cisco.com/en/US/products/sw/custcosw/ps1006/index.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1006/index.html
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Example Record Greeting Prompts

Unified CCE includes three example record greeting audio prompts. These are installed on each ICM 
server at <icm_root>\wav. These example files are referenced in the example recording script that are 
included with ICM. If you plan to deploy the example script, copy the audio prompts to the 
<web_server_root>en-us\app directory on your media server.

Configuring Dialed Numbers and Call Types for Agent Greeting Record and Play
in Unified CCE Configuration Manager, create the following:

1. Using the Call Type list tool, create two new call types to use for recording and playing Agent 
Greeting. (For clarity, you may want to name them RecordAgentGreeting and PlayAgentGreeting.)

2. Using the Dialed Number list tool, add two dialed numbers: RecordAgentGreeting and 
PlayAgentGreeting. The numbers must be specified literally as they appear here. They are 
case-sensitive. For each set the Media Routing Domain to Cisco_Voice.

3. Using the Dialed Number list tool, on the Dialed Number Mapping tab, map the RecordAgentGreeting 
and PlayAgentGreeting dialed numbers to their respective call types.

Defining Network VRU Scripts for Agent Greeting
You need a number of Network VRU scripts so your Agent Greeting record and play scripts can interact 
with CVP at various points. Create these in Unified CCE Configuration Manager using the Network 
VRU Script List Tool. How many VRU scripts you need and how you configure them depends on how 
you choose to script Agent Greeting.

Here is an example set of Agent Greeting Network VRU Scripts based on the example Agent Greeting 
scripts that are included with ICM, For each:
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• The Network VRU must be a Type10 

• The default timeout 180 is acceptable 

• Leave Overridable unchecked 

ICM Name
VRU Script 
Name

Configuration 
Parameter Interruptible What it does

AgentGreeting PM,-a N Causes a saved greeting audio 
file to play. The -a parameter 
automatically generates the file 
name by concatenating the 
agent's Login Name with the 
AgentGreetingType variable 
value set in your routing scripts 
that target an agent. 

GreetingMenu_1_

to_9 

M,press_1_thr
u_9_greeting,
A 

1-9 X During a recording session, play 
an audio file that presents a voice 
menu prompting the agent to 
press the number corresponding 
to the greeting he or she wants to 
record. The 1-9 configuration 
parameter defines the range of 
allowable keys. So this value 
also determines the number of 
concurrent greetings agents can 
have. The “A” parameter 
specifies the file is in the 
(default) Application directory 
on the CVP VXML Server. 

GreetingSubMenu M,press1-press
2-press3,A

1-3 X During a recording session, play 
an audio file that prompts the 
agent to press 1 to listen to a 
greeting, 2 to record, 3 to go to 
the main menu. 
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Note For descriptions of VRU Script Name parameters and detailed instructions on creating Network VRU 
scripts for CVP micro-applications, see the Configuration and Administration Guide for Cisco Unified 
Customer Voice Portal.

Greeting_

Not_Found 

PM,no_

greeting_

recorded,A

Y X During a recording session, if an 
agent tries to play back a 
greeting that does not exist, play 
the no_greeting_recorded audio 
file. The Y configuration 
parameter Y in this instance 
allows barge-in (digit entry to 
interrupt media playback). 

T10_GS_AUDIU
M 

GS,Server,V ,,,,,,,,,,Y X This starts the external VXML 
application that records the 
greeting. The VRU script name 
must be specified exactly as 
shown, case-sensitive. 

The Y parameter in the eleventh 
position of the Configuration 
Parameter is required. It allows 
the script to pass FTP connection 
information to the VXML 
Server. The VXML server then 
uses this information to make an 
FTP connection to the media 
server when saving greeting 
files. 

ICM Name
VRU Script 
Name

Configuration 
Parameter Interruptible What it does

http://www.cisco.com/en/US/products/sw/custcosw/ps1006/tsd_products_support_configure.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1006/tsd_products_support_configure.html
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Creating the Agent Greeting Scripts
Agent Greeting requires two new call routing scripts: one to record the greeting and one to play it. You 
must also set the AgentGreetingType variable in your existing agent-targeting scripts for the routing 
client.

Creating an Agent Greeting Record Script

You require a dedicated routing script that allows agents to record greetings. The script should be called 
from the agent desktop when an agent clicks the Record Greeting button. If you support multiple 
greetings per agent, it should include prompts to select which greeting to play or record. The dialed 
number RecordAgentGreeting must be created for the specific routing client and associated with a call 
type which then executes this script.

In the example script shown here, the agent is first prompted to select one of nine possible greeting types 
he or she wants to work with. After selecting a greeting type the agent chooses whether to 1) listen to 
the existing greeting for that type; 2) record a new greeting for that type, or... 3) return to the main menu. 
If the option to listen is selected, the name of the application directory on the media server is set and the 
external VRU script that plays the greeting is triggered. Afterwards the agent is returned to the main 
menu. If the option to record is selected, the CVP recording application is called. The recording 
application contains its own built-in audio prompts that step the agent through the process of recording 
and saving a greeting. At the end the agent is returned to the main menu.

There are several other behaviors in the script to note: An agent may select to listen to a greeting type 
for which no greeting exists. In that event a VRU script which plays an error message is called. Also, in 
two places in the script the path to the application directory is reset to the default. This is because (in 
this example) that is where the files for the audio files reside. The only files that reside outside of the 
default directory are the greetings themselves.
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Call Type Association

You must associate the Agent Greeting record script with the call type for the RecordAgentGreeting 
dialed number.

About the RecordAgentGreeting Micro-Application

CVP includes a dedicated micro-application -- RecordAgentGreeting -- for recording agent greetings. 
The application lets agents record, review, re-record, and confirm the save of a greeting. It includes audio 
files to support each of these functions. If an agent is not satisfied with a greeting, it can be re-recorded 
up to three times. Upon confirmation of a save, the application FTPs the saved file to the media server. 
Built-in error checking includes checks for the data required to name the file (agent Login Name + 
AgentGreetingType variable value), media server specification, valid menu selections made by the 
agent, and successful FTP of the greeting file.

Agent Greeting Record Script Nodes

Using the example script as a reference, here are descriptions of the functions its nodes perform.

Node Value What it Does

Variable:Call:user.

microapp.input_type 

D Sets the allowable input type to DTMF (touch 
tone). 

RunExtScript:Press 1-9 
to Select Greeting X

M,press_1_thru_9_

greeting,A 

Runs the VRU script that defines which digits are 
valid to select an AgentGreetingType and plays a 
voice prompt describing the options. 

Variable:Call:AgentGre
etingType 

Call.

CallerEnteredDigits 

Sets the AgentGreetingType to the digit the agent 
pressed. This text is used in the greeting wave file. 
It can be a simple numbering system or more 
descriptive titles such as “English.” 

RunExtScript: 

1 - hear greeting X, 

2 - record greeting X, 

3 - return to menu 

M, 
press1-press2-press3, A 

Runs the VRU script that defines which digits are 
valid to select a desired action and plays a voice 
prompt describing the options. 

CED 1, 2, 3 Tells the script how to handle the caller entered 
digits in response to the 1,2,3 external script. 

Variable:Call:user.micr
oapp.app_media_lib 

Set three times, once to 
“app/ag_gr” and twice 
to “” 

Defines the path to the application directory on the 
CVP media server. Prior to playing greeting file, it 
is set to the dedicated greeting file directory (in 
this example, “app/ag_gr”). Afterwards it is reset 
to the default application directory where (in this 
example) the voice prompts for recording are 
stored. If the voice prompts were stored in the 
same directory as the greeting files, there would be 
no need to reset the path. 

RunExtScript: Play 
Recording 

PM,-a,A Runs the VRU script that plays the selected Agent 
Greeting. 

RunExtScript:Greeting 
Not Found 

PM,no_greeting_record
ed,A 

Runs the VRU script that plays an error message if 
the Agent Greeting selected to play does not exist. 
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Specifying the Media Server in Routing Scripts

You can define a default media server in your CVP Operations Console. If you do this, and if that is the 
server from which you serve your Agent Greeting files, then you need not specify the media server in 
your routing scripts. However, if you do not define a default media server, or if you store your greeting 
files on a server other than the default, then your scripts must include a Set Variable node that identifies 
that server.

Use these settings in the Set Variable node to specify your media server:

• Object Type: Call

• Variable: Must use the user.microapp.media_server ECC variable.

• Value: Specify the HTTP path to the server. For example: “http://myserver.mydomain.net” You must 
enclose the path in quotes.

• Alternately you can specify an IP address in place of a DNS. Include the listening port number if 
the media server's web server listens on a port other than 80 (for HTTP) or 443 (for HTTPS).

Additional Required Variables When Specifying the Media Server

In scripts that invoke an external VXML application (as the Agent Greeting record script does) if you do 
explicitly set a variable for the media server (user.microapp.media_server) then you must also include 
variables that set:

1. The path to the media server application directory (user.microapp.app_media_lib)

2. The CVP UseVXMLParams value to N.(user.microapp.UseVXMLParams)

Without these variables the script does not run.

Variable:

Call:user.microapp.

ToExtVXML[] 

Array Index: 2

Value: 
“ftpPath=<path/to/dedi
cated/directory>en-us/a
pp/ag_gr”

Example: 
“ftpPath=en-us/app/ag_
gr” 

Specifies the FTP information the VXML server 
uses to write greeting files to the media server. The 
information must match the FTP information 
configured for the media server in the CVP 
Operations Console. 

The array index must be set to 2.

The value consists of: 1. ftpPath sets the path to 
the dedicated directory for agent greeting files. 

It must begin with the locale directory. 

See your CVP documentation for additional 
setting options. 

Variable:

Call:user.microapp.

ToExtVXML[] 

Array Index: 0 

Value: 
“application=RecordAg
entGreeting” 

Identifies the external CVP micro-application 
(RecordAgentGreeting) that is used to record the 
greeting. 

The array index must be set to 0. 

RunExtScript: Run 
Default Recording 
Application 

GS,Server,V Runs the VRU script that launches the Get Speech 
micro-application on the VXML server. 

Node Value What it Does

http://www.cisco.com/en/US/products/sw/custcosw/ps1006/index.html
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Specifying the Greeting File Locale and Application Directories in Routing Scripts

CVP uses a default storage directory for media files: <web_server_root>/en-us/app. To take advantage 
of this, Unified CCE call routing scripts automatically add “en-us/app” to the server name when 
constructing HTTP requests for media files. Further, For example:

• If the script node that defines the media server has a value of “http://myserver.mydomain.com” 
and... 

• The script node that defines which audio file to play has a value of “agent123_1.wav”, then... 

• The HTTP request for the file is automatically constructed as 

http://myserver.mydomain.com/en-us/app/agent123_1.wav
If your greeting audio files are stored in a different locale directory, you must add a Set Variable node 
to your script that identifies the locale directory. As you must store your greeting files in a dedicated 
subdirectory under the locale, you must always add a Set Variable node that identifies that directory.

Specifying the Locale Directory

Use these settings in the Set Variable node to specify your locale directory:

• Object Type: Call.

• Variable: Must use the user.microapp.locale ECC variable.

• Value: Specify the directory name. For example: “pt-br” (Portuguese-Brazil) You must enclose the 
path in quotes.

Specifying the Application Directory

Use these settings in the Set Variable node to specify your application directory:

• Object Type: Call.

• Variable: Must use the user.microapp.app_media_lib ECC variable.

• Value: Specify the directory name. For example: to use a directory “greet” in place of the default 
directory “app” enter “greet”. To use a sub-directory “greet” “app” enter “app/greet”. You must 
enclose the path in quotes.

Variable Length for Media Server, Locale, and Application Directory Variables

If you do include Set Variable nodes for the media server, locale, and/or application directories, make 
sure that the values you set for them do not exceed the Maximum Length settings for their corresponding 
ECC variables.

For example, suppose you include a Set Variable node for the media server with a value of 
“http://mysubdomain.mydomain.co.uk” That string is 33 characters long. Therefore, the Maximum 
Length setting for the user.microapp.media_server ECC variable must be 33 or greater. If it is not, you 
must increase the Maximum Length setting. Otherwise the server name is truncated in the HTTP request 
for the file and the file is not found. You configure ECC variables in the Unified CCE Configuration 
Manager at List Tools > Expanded Call Variables List.
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Testing Your Agent Greeting File Path

To test the path you defined to the greeting file in your script variables, plug the complete URL into a 
browser. The wave file should play. For example:

• If your script uses a default media server whose IP is 192.1.1.28 + the default locale + an application 
directory named “greet” + agent123_1.wav, then the generated URL should be 
“http://192.1.1.28/en-us/app/greet/agent123_1.wav.” Entering this URL into a browser should cause 
this agent’s greeting to play.

• If your script includes: “http://my_server.my_domain.com” + the default locale + an application 
directory “app/greet” + agent123_1.wav, then the path should be 
“http://my_server.my_domain.com/en-us/app/greet/agent123_1.wav.”

Using Descriptive Agent Greeting Type Strings

The previous Agent Greeting record script example stores Agent Greeting Type values as numbers 
(albeit in string format). But suppose you prefer more descriptive string names? For example, “English,” 
“French,” and “Spanish.” Or “Sales,” “Billing,” and “Tech Support.” Descriptive names can make it 
easier to understand at a glance what different numeric key selections in your scripts correspond to. Note 
that they also affect how greeting files are named (for example “agent123_English.wav” as opposed to 
“agent123_1.wav”).

The following script example is almost identical to the previous record script, except that it includes four 
additional nodes (highlighted in green). They consist of an additional CED node that maps the keys 1, 
2, and 3 to language names. The Run Ext Script node (in gray) was modified for the new options. The 
rest of the script is the same with no other changes required. Note that your routing scripts require a 
corresponding mapping of numeric keys to language names.
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Creating an Agent Greeting Play Script

You require a dedicated routing script that causes the agent greeting to play. This script is invoked by the 
PlayAgentGreeting dialed number on the specific routing client. The dialed number must be created and 
associated with a call type that then executes the script.

The Play script must contain two and possibly four specific nodes.

Always Needed

1. A Run External Script node that calls the VRU script that plays the greeting.

2. A Set Variable node that sets the directory path to your greeting files.

Possibly Needed

You may also need to include in your scripts Set Variable nodes that:

1. Specify the Media Server: CVP lets you specify a default media server. If you are not serving your 
audio files from the default media server, your scripts must include a variable that identifies the 
server where your audio files are stored.

2. Specify the Locale Directory: Additionally, if you are not storing your whisper files in the default 
locale directory (“en-us”) on the media server, you must include a variable that specifies the name 
of the locale directory where the files are stored.

Call Type Association

You must associate the Agent Greeting play script with the call type for the PlayAgentGreeting dialed 
number.



3-15
Agent Greeting and Whisper Announcement Feature Guide for Cisco Unified Contact Center Enterprise

Release 8.5(x)

Chapter 3      How to Deploy and Configure Agent Greeting
  Configuring Your Media Server for Agent Greeting

Modify Call Routing Scripts to Use the Play Agent Greeting Script
For an Agent Greeting play script to run, you must add an AgentGreetingType call variable node to your 
existing routing scripts: This variable's value is used to select the audio file to play for the greeting. Set 
the variable before the script node that queues the call to an agent (that is, the Queue (to Skill Group), 
Queue Agent, Route Select, or Select node).

Specifying the AgentGreetingType Call Variable

To include Agent Greeting in a script, insert a Set Variable node that references the AgentGreetingType 
call variable. The AgentGreetingType variable causes a greeting to play and specifies the audio file it 
should use. The variable's value corresponds to the name of the greeting type for the skill group. For 
example, if there is a skill group for Sales agents and if the greeting type for Sales is '5', then the variable 
value to 5.

You can use a single greeting prompt throughout a single call type. As a result, use one 
AgentGreetingType set node per script. However, as needed, you can set the variable at multiple places 
in your scripts to allow different greetings to play for different end points. For example, if you do 
skills-based routing you can specify the variable at each decision point used to select a particular skill 
group.

Note Only one greeting can play per call. If a script references and sets the AgentGreetingType variable more 
than once in any single path through a script, the last value to be set is the one that plays.

Use these settings in the Set Variable node for Agent Greeting:

• Object Type: Call.

• Variable: Must use the AgentGreetingType variable.

• Value: Specify the value that corresponds to the greeting type you want to play. For example: “2” or 
“French” 

– You must enclose the value in quotes.

– The value is not case-sensitive. 

– The value cannot include spaces or characters that require URL encoding.
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Scripting Agent Greeting for Multiple Customers

In the out-of-box method for deploying Agent Greeting, Unified CCE uses the customer information 
from the built-in “PlayAgentGreeting” dialed number to choose the correct network VRU to play the 
greeting. If your deployment has multiple customers configured within your Unified CCE instance and 
you want to use Agent Greeting with all of them, you must configure things differently to work around 
customer associations.

Configuring a Custom Dialed Number for Agent Greeting Play

To play Agent Greetings for multiple customer instances, configure the built-in PlayAgentGreeting 
dialed number for each Unified CM routing client, but do not associate it with a specific customer. The 
Unified CM peripheral uses this number to initiate Agent Greeting play. If you want your greetings to 
be played from a different network VRU, use the TranslationRouteToVRU node in your routing scripts 
to explicitly choose the network VRU.

Configuring a Custom Dialed Number for Agent Greeting Record

To record Agent Greetings when you have multiple customers you'll need to create your own custom 
dialed number for recording. You may want to create different dialed numbers for different customers. 
As with Agent Greeting play, if you want to use different network VRUs to record Agent Greetings for 
different customers, use the TranslationRouteToVRU node in your routing script to explicitly select the 
network VRU.
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When you create your own dialed number to record greetings you cannot use the default Record Greeting 
button that ships with CTI OS (as it is associated with the hard-coded “RecordAgentGreeting” DN). 
Create your own custom button or have your agents enter the record dialed number using the dial pad on 
their desktops.

Including the Agent Greeting Controls in Your Agent Desktops
CTI OS includes Active X objects that let you include Agent Greeting controls in your COM and C++ 
sourced agent desktops. Available controls include Enable Greeting, Disable Greeting, and Record 
Greeting. See your CTI OS Developer's Guide for more information. Agent Greeting controls are not 
supported with Java or .NET based CTI OS desktops, or with non-CTI OS desktops such as CAD.

Agent Greeting Example Scripts
ICM includes example routing scripts that demonstrate Agent Greeting. You can use them as learning 
tools and as models for your own Agent Greeting scripts. The script files are located in the icm\bin 
directory. They include:

• AG.ICMS This script sets up an Agent Greeting.

• PAG.ICMS This script causes an Agent Greeting to play. 

• RECORD_AG.ICMS This script lets agents record a greeting. 

• WA_AG.ICMS This script plays a Whisper Announcement and an Agent Greeting together on the 
same call flow.

Note The APG.ICMS and RECORD_AG.ICMS example scripts assume that a default media server is 
configured in CVP, and the greeting files are stored in a dedicated directory named ag_gr directory. The 
WA_AG.ICMS script does not include a dedicated directory.

About the AG.ICMS Script
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This script sets up an Agent Greeting by setting the greeting type to be used on the call and then queueing 
the call to a skill group. Once an agent is selected from the skill group and the call routed to the agent, 
the PAG.ICMS script is invoked.

About the PAG.ICMS Script

This script causes an Agent Greeting to play. It is invoked by the “PlayAgentGreeting” dialed number 
on the specific routing client. The dialed number must be created and associated with a call type that 
then executes the script.



3-19
Agent Greeting and Whisper Announcement Feature Guide for Cisco Unified Contact Center Enterprise

Release 8.5(x)

Chapter 3      How to Deploy and Configure Agent Greeting
  Configuring Your Media Server for Agent Greeting

About the RECORD_AG.ICMS Script

This script lets agents record a greeting. It is called from the agent desktop when an agent clicks the 
Record Agent Greeting button. It prompts the agent to select which greeting to play or record. The dialed 
number “RecordAgentGreeting” must be created for the specific routing client and associated with a Call 
Type that then executes this script.

About the WA_AG.ICMS Script

This script causes both a Whisper Announcement and an Agent Greeting to play.
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How to the Import the Example Agent Greeting Scripts
To view or use the example Agent Greeting scripts, you must first import them into Unified CCE Script 
Editor. To import the scripts:

1. Launch Script Editor.

2. Select File > Import Script and select the first of the three scripts to import.

3. In addition to importing the script, Script Editor maps imported objects. Some objects referenced in 
the example scripts, such as the external Network VRU scripts or the skill groups, do not map 
successfully. You must create these manually or change these references to point to existing scripts 
and skill groups in your system.

4. Repeat these steps for the remaining scripts.
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Using Agent Greeting with Your CTI OS Agent or 
Supervisor Desktop

This chapter describes how to use Agent Greeting from the CTI OS Agent or Supervisor desktop.

How to Record a Greeting
Recording an Agent Greeting is very similar to recording a personal message for your voice mail. To 
record a greeting, you must be logged in to your desktop software and in the Not Ready state.

To record a greeting:

1. Click the Agent Greeting Record button on your desktop.

2. You may hear a brief ring tone, after which you receive voice instructions for recording a greeting. 
Options may include selecting a greeting type (if your contact center uses more than one greeting 
per agent), recording, playing back, and confirming whether to use the new greeting. There is also 
an option for listening to your existing greetings.

3. After you connect to the Record Greeting service, a dialog box containing a dial pad appears on your 
agent desktop. You can use the dial pad or the keypad on your phone to make your selections. (If 
you close the dialog box before you finish recording your greeting you cannot re-open it; use the 
keypad on your hard phone to complete your recording.)

4. To exit without recording a greeting, release the call.

The number greetings you require is determined by your contact center. It may vary depending on things 
like your skill group membership or the time of day or day of the week. Your contact center also 
determines how long your greeting can be. When you are recording, if you reach the maximum recording 
time, you receive a notification.
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How to Delete a Greeting
You cannot delete an agent greeting. However, you can record over previously recorded greetings. When 
you record over a greeting, the new greeting is used for the next customer call you take.

How to Review Your Greetings
To listen to your current greetings, click the Agent Greeting Record button on your desktop and select 
the greeting to listen to.

Enabling or Disabling Greeting Play
Your CTI desktop toolbar includes a Greeting button that you can use to turn the Agent Greeting feature 
on or off. There are various reasons you might want to turn off your greeting. You might want to turn off 
your greeting on a day when you have a cold and you are concerned that your voice does not sound like 
your recorded message. Or you might want to turn off a greeting that was appropriate yesterday but is 
not today, until you have time to go Not Ready and record a new one. Turning off Agent Greeting does 
not affect a greeting that is already playing to a caller.

Turning off Agent Greeting stops your greetings from playing until you manually turn it back on again, 
or until the next time you log in to the desktop; Agent Greeting is always automatically turned on at 
login.

To turn Agent Greeting off, with Greeting enabled, click the Greeting button.  

To turn Agent Greeting back on, click the button again. 

Using Agent Greeting with the Outbound Agent Desktop
Agent greetings play to inbound callers only; they do not play when you make an outbound call. If you 
are an outbound-only agent, you can still record greetings but they do not play, even when Agent 
Greeting play is turned on in your desktop toolbar.

Agent Greeting During Transfers and Conferences
For transferred and conference calls, Agent Greeting support is limited to BiB-enabled phones. Other 
than that, Agent Greeting functions much the same for blind transfer and conference calls as it does for 
customer calls. When you blind transfer a call to another agent, your customer hears the other agent's 
greeting (assuming that agent has greeting enabled). Similarly, when you conference in another agent, 
all parties on the call hear the other agent's greeting.

Consultative transfers work a little differently. When you place a consultative transfer, your customer 
does not hear the other agent's greeting. (Provided of course that you do not transfer the customer while 
the other agent's greeting is still playing.)
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If Your Agent Desktop Closes
If, while you are logged in, your CTI OS Agent Desktop software closes for any reason, when you 
relaunch it your Agent Greeting state is set to Enabled.
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Using Agent Greeting with Your CAD Agent or 
Supervisor Desktop

This chapter describes how to use Agent Greeting from the CAD Agent or Supervisor desktop.

Recording a Greeting
There is no button support for Agent Greeting in CAD desktops. To record a greeting:

1. On your desktop, open the Make a Call dialog.

2. In Name: Number, type or paste “RecordAgentGreeting” (case-sensitive).

3. Check the Dial Number As Entered box.

4. Click Dial.

5. Once the recording session starts, use the Dial Pad on your desktop or the keys on your hard phone 
to respond to prompts.
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Adding a customized Task Button in the CAD Agent for 
Recording an Agent Greeting

Adding a customized button to allow the Agent to record an Agent Greeting simplifies the Agent 
Greeting recording, reducing keystrokes for each agent.

1. Open the CAD Agent.

2. Open the CAD Work Flow Administrator.

3. Navigate to the CAD Agent - User Interface.

4. Choose an available Task.

5. Check the visible box.

6. Enter Record Agent Greeting in the hint edit box.
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7. Click the Add button. 

8. Choose the Run Macro Tab. 

9. Click New button.
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10. Enter RecordAgentGreeting. 

11. Click the OK button.

12. Click the Record button. 
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13. Follow the directions above for Recording a Greeting. 

14. When finished restore the Record dialog from the taskbar and click the Stop button. 

15. Modify the script as follows:

16. Click Ok
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17. Click the Add Action button
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18. Close the CAD Work Flow Administrator and save all changes.

19. Restart the CAD Agent.

The button appears on the CAD Agent desktop when the agent desktop is restarted.

Disabling Agent Greeting
There may be times when you do not want your greeting to play to callers. But as a CAD agent you 
cannot turn off the Agent Greeting feature--if it is enabled for your call center, it is always on. As an 
alternative to disabling Agent Greeting, you can record as your greeting a brief (one second) message 
consisting of silence. This should mimic no greeting as far as the caller experience is concerned.
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Agent Greeting in a Parent/Child Deployment

Agent Greeting for Parent/Child is only supported for a very specific Parent/Child configuration. Agent 
Greeting in Parent/Child configurations must be approved by the Cisco Assessment to Quality (A2Q) 
process and require Cisco Design Mentoring Service to assure that the deployment model is designed 
and sized correctly to support the Agent Greeting feature.

After the call is delivered to the child system, the child router picks the target agent, the agent answers 
the call, and then CVP plays an agent greeting to both the caller and the agent. This feature is supported 
for both local agents and mobile agents.

On the child Unified CCE, you must:

1. Use IP-IVR on the child for call treatment, queuing and Whisper Announcement (if Whisper 
Announcement is enabled).

2. Use CVP on the child for Agent Greeting only; not for call queuing. You must use a separate VRU 
PG for the CVP. Translation route is used to send the greeting call to CVP.

Configuration Tasks
You must complete following tasks on the child to translation route the call to the CVP.

1. Define a VRU PG for CVP.

2. Define a Type10 Network VRU for CVP.

3. Associate the Network VRU to the VRU PG. In the Network VRU configuration, configure the CVP 
Voice Gateway label for the CVP routing client so that the CVP Call Server can send the call to the 
gateway to play greetings.

4. Associate Network VRU scripts with the VRU PG.

5. Configure ECC variables for CVP.

6. Associate the Network Trunk Group with the VRU PG. By default, CVP uses trunk group# 100 for 
incoming calls and 200 for out going calls. In ICM Network Trunk Group config tool, set the 
Peripheral Number to 200 for the CVP trunk group.

7. Associate the VRU Service with the VRU Peripheral.

8. Associate the Translation Route with the VRU service. Configure translation route labels for the 
system PG routing client so that the UCM can send the call to CVP.

9. Configure UCM to send the calls to CVP with the translation route labels.

10. Configure CVP DNIS for the translation route labels.
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11. Configure the routing scripts.

Configuring the Routing Scripts
You must configure following routing scripts:

• AG.ICMS 

• PAG.ICMS

• record_ag.ICMS

You can find sample scripts in the \icm\bin folder.

Configuring the AG.ICMS Routing Script
1. In the existing routing script, before sending the call to agents, add a Set node.set the 

AgentGreetingType call.

2. In the Call.AgentGreetingType variable, configure the agent greeting type.

Configuring the PAG.ICMS Routing Script
To translation route the greeting request to CVP and play agent greeting, configure the PAG.ICMS 
routing script. The following illustration is an example of how to modify the sample PAG.ICMS script.
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Configuring the record_ag.ICMS Routing Script
To translation route the recording request to CVP and record an agent greeting, configure the 
record_ag.ICMS routing script. The following illustration is an example of how to modify the sample 
record_ag.ICMS script.
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Troubleshooting Agent Greeting

This chapter describes how to troubleshoot the Agent Greeting feature.

Debugging Agent Greeting Scripts
The Script Editor Call Tracer utility, which tests and debugs routing scripts to confirm the selection of 
Unified CCE targets, includes these fields for debugging Agent Greeting scripts:

• Agent (the Enterprise Agent ID), 

• Greeting (the greeting type), and 

• Customer (the instance)

Monitoring Agent Greeting
As a general monitoring/troubleshooting practice for Agent Greeting, you may find it best to review log 
files on your Peripheral Gateway in this order:

1. Review the Windows Event Viewer Application log first. It is easier and faster to locate errors here.

2. If you find an error in Windows Event Viewer, note the time. Then use the ICM Dumplog utility to 
export the contents of your ICM logs to a human-readable file that you can consult for more detail. 
Dumplog outputs files to <icm_root>\<instance>\<pg_name>\logfiles\.

Agent Greeting Frequently Asked Questions
What is the maximum number of greetings an agent can have?

Unified CCE does not impose a limit on how many greetings your agents can have. You determine the 
limit in the way you design your scripts. The number of numeric keys on a dial pad imposes a practical 
limit of nine; However, this can be gotten around by including nested CED nodes in your routing scripts 
that allow agents to drill-down to the greeting type they want to record.

I work at a large company that has both internal and external tech support agents. The types of greetings these two groups need 
are not the same. Can I deploy different Agent Greeting scripts for different types of agents?

Yes. The best way to do this depends on how your agents are created in the system.

http://docwiki.cisco.com/wiki/Main_Page
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For example, if your internal and external agents are created on separate routing clients, you can simply 
create different Agent Greeting scripts for each of the two routing clients. If internal and external agent 
records are mixed together on a single routing client you need a different approach. You can create a 
script that uses agent Login IDs to direct them to the correct Agent Greeting record script. Or one that 
requires agents to select their agent type from a menu and then uses that information to select the right 
Agent Greeting script.

How do I disable agent greeting?

Individual CTI OS agents can disable Agent Greeting through their desktops. To disable Agent Greeting 
for groups, remove the call to the Agent Greeting play script from your call routing scripts.
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About Whisper Announcement

Whisper Announcement plays to an agent a brief, prerecorded message just before the agent connects 
with each caller. The announcement plays only to the agent; the caller hears ringing (based on existing 
ring tone patterns) while the announcement plays.

The content of the announcement can contain information about the caller that helps prepare the agent 
to handle the call. The information can include caller language preference, choices the caller made from 
a menu (Sales, Service), customer status (Platinum, Gold, Regular), and so on.

You enable Whisper Announcement and specify which announcements to play in your Unified CCE call 
routing scripts. Because the determination of which announcement to play is controlled programmatically, 
you can select which announcement to play based on various inputs such as the dialed number, a customer 
ID look up in your customer database, and selections made from a VRU menu.

System Requirements and Functional Limitations
To use Whisper Announcement, your system must meet these baseline requirements.
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Software Requirements
These software pieces must be in place to deploy Whisper Announcement.

Hardware Requirements
These hardware pieces must be in place to deploy Whisper Announcement:

What Requirement

Unified CCE Software 
Versions 

To use Whisper Announcement, your Unified CCE deployment must 
be running: 

• Unified CCE, Release 8.5(1) or later (Mobile Agent requires 
Unified CCE, Release 8.5(2) or later) 

• Unified CVP, Release 8.5(1) or later 

• Unified CTI OS, Release 8.5(1) or later 

• Unified CM, Release 8.5(1) SU2 or later 

• Unified CCX, Release 8.5(1) SU1 + 
ciscouccx.851SU1agentwhisper.cop.sgn

Deployment Models In Enterprise deployments of Unified CCE, Whisper Announcement 
is supported only with Unified CCE and Unified CVP. 

Beginning with ICM/UCCE 8.5(2), in a parent-child deployment, 
Whisper Announcement is supported only in a Unified CCE system 
PG with IP-IVR on the child. 

Whisper Announcement is not supported with hosted deployment 
models.  

Agent Types Whisper Announcement is supported for blended outbound agents 
when they receive inbound calls. 

Agent Desktops There is no direct integration between Whisper Announcement and 
agent desktop software; you can use Whisper Announcement 
alongside any Unified CCE-compatible agent desktop software. 

What Requirement

Phones Whisper Announcement works with Unified CM supported IP phones. 
See the Unified CCE Compatibility Matrix for the list of supported 
phones. 

CVP Call Control Protocols Whisper Announcement is supported with SIP as the CVP call control 
protocol. H.323 is not supported. .  
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Configuration Requirements
To deploy Whisper Announcement, the following configuration pieces must be in place.

Where What

Unified ICM Whisper Announcement is supported with Type 10 Network VRUs only. 
(Type 10 is required to allow CVP to control the call). If your current 
Unified CCE deployment is not configured for a Type 10 VRU, you must 
modify it accordingly. 

Whisper Announcement does not require Extended Call Context (ECC) 
variables provided that you: 

• Retrieve your files from the CVP default media Whisper 
Announcement Sample Scripts

• Store your files in the media server default locale and application 
directories (“<web_server_root>\en-us\app”).

However, if you store your files in a location other than these 
defaults, you must use one or more of the following ECC variables 
in your scripts. To make these variables available, verify that they 
are defined in the Unified CCE Configuration Manager tool.

• user.microapp.media_server: Use to identify the CVP media 
server if it is other than the default.

• user.microapp.locale: Use to specify the name of the locale 
directory on the media server if it is other than the default (“en-us”).

• user.microapp.app_media_lib: Use to specify the name/path of 
the application directory on the media server if it is other than the 
default (“app”). See the Configuration and Administration Guide 
for Unified CVP for instructions on defining ECC variables for CVP.

Unified CVP Deploy the files for the CVP gateways and complete configuration. You 
can deploy gateway templates from the CVP Management Console to 
the gateways. 

Configure the CVP SIP subsystem, and configure the dial plan on the 
SIP Proxy or with the local static route configuration. This includes the 
routing for the dialed number used with whisper service calls 

Unified CCX Note This is for Parent/Child deployments only. Whisper 
Announcement for Parent/Child is only supported for a very 
specific Parent/Child configuration. Whisper Announcement in 
Parent/Child configurations must be approved by the Cisco 
Assessment to Quality (A2Q) process and require Cisco Design 
Mentoring Service to assure that the deployment model is 
designed and sized correctly to support the Whisper 
Announcement feature.

Configure IP-IVR on the child. Call queuing is completed on the child. 
For more information, see Chapter 11, “Whisper Announcement in a 
Parent/Child Deployment.”
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Note To deploy Whisper Announcement in a Parent/Child deployment, Unified CCX (IP IVR) is required on 
the child. Calls are queued on the child

Functional Limitations
Whisper Announcement is subject to these limitations:

• Whisper Announcement is not supported with outbound calls made by an agent. The announcement 
plays for inbound calls only. 

• For Whisper Announcement to work with agent to agent, you can use the SendToVRU or 
TranslationRouteToVRU node before the call is sent to the agent. The transferred call must be sent 
to Unified CVP before it is sent to another agent, so that Unified CVP can control the call and play 
the Whisper Announcement, regardless of which node is used to send the call to CVP. 

• Whisper Announcements do not play when the router selects the agent via a label node. 

• Whisper Announcement is not supported with SIP Refer Transfers.

• Only one Whisper Announcement file plays per call. 

• Silent Monitoring (CTI OS and Unified CM-based) is supported with Whisper Announcement with this 
exception: For Unified-CM based Silent Monitoring, supervisors cannot hear the announcements 
themselves. The Silent Monitor button on the supervisor desktop is disabled while an announcement is 
playing.
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9
How Whisper Announcement Works

This chapter describes how the Whisper Announcement feature works.

The Whisper Announcement Audio File
You store and serve your Whisper Announcement audio files from the Unified CVP media server. Wave 
(.wav) is the only supported file type. The maximum play time for a Whisper Announcement is subject 
to a timeout. If the timeout is reached, play terminates regardless of the actual length of the wave file. 
The default timeout is fifteen seconds. In practice, you may want your messages to be much shorter than 
that, in the area of five seconds or less.

While a Whisper Announcement is Playing
Only one Whisper Announcement can play per call. During the time a Whisper Announcement is 
playing, you cannot put the call on hold, transfer, conference, or release the call, or request supervisor 
assistance. These features become available again once the whisper is complete.

Whisper Announcement With Transfers and Conference Calls
When an agent transfers or initiates a conference call to another agent, the second agent hears a whisper, 
assuming that the number dialed to reach the second agent is configured to hear them. In the case of 
consultative transfers or conferences, while the whisper plays, the caller hears hold music or whatever 
else is configured to play during hold. The first agent hears ringing. In the case of blind transfers, the 
caller hears ringing while the whisper plays.
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Whisper Announcement Call Flow

1. CVP receives a new call from the PSTN.

2 - 3. CVP sends the new call to the VRU PIM and the VRU PIM sends the new call to the Unified CCE 
router.

4. If an agent is available, the router reserves the agent.

5 - 6. The router sends a label with a whisper prompt to CVP.

7. CVP sends the call to Unified CM.

8 - 9. The agent receives and answers the call.

10. Unified CM sends the established event to the agent PIM. The agent PIM holds the event until the 
Whisper Announcement is done playing.

11. CVP tells the VXML gateway to play ringback to the caller and the Whisper Announcement to the 
agent. After the Whisper Announcement plays, CVP connects the agent to the customer and notifies 
Unified CCE.

12. The agent PIM gets notification that Whisper Announcement is complete and sends the established event 
to the agent desktop.
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Whisper Announcement Reporting and Serviceability
Whisper time is not specifically broken out in Unified CCE reports. In agent and skill group reports the 
period during which the announcement plays is reported as Reserved agent state time. In the Termination 
Call Detail records it is treated as Ring Time.

Serviceability for Whisper Announcement includes system events to indicate reasons for Whisper 
Announcement failures and counters to track the number of failed whisper events. See the 
Troubleshooting Unified CCE DocWiki for more information.

Component Failure and Whisper Announcement 

Failover of ICME and CTI OS Server

In a duplexed deployment, when a router, logger, peripheral gateway, or CTI OS Server fails over, 
Whisper Announcement is unaffected; Whispers play normally with no interruption. Note that when fail 
over occurs, reporting data on Whisper Announcements playing at that time may be inconsistent. For 
example, whisper time may be counted as talk time (instead of ring time, as normal).

Failure to Access CVP Media Server

If the connection to the CVP media server fails, or if a requested whisper audio file cannot be found, the 
call proceeds normally without Whisper Announcement.

Whisper Announcement in Agent Desktop Software

There is no configuration needed to integrate Whisper Announcement with agent desktop software. 
While a whisper announcement is playing, agent desktop soft phones show the call in the Ring state. 
Hard phones show the call in the Talking state.

Using Agent Greeting with Whisper Announcement

You can use Agent Greeting along with the Whisper Announcement feature. Here are some things to 
consider when using them together:

• On the call, the Whisper Announcement always plays first before the greeting. 

• To shorten your call-handling time, you may want to use shorter whispers and greetings than you 
might if you were using either feature by itself. A long whisper followed by a long greeting means 
a long wait before an agent is actually actively handling a call. 

• By its nature, when you use a whisper it means that your agents are probably handling different types 
of calls: for example, “English-Gold Member-Activate Card,” “Spanish-Gold Member-Report Lost 
Card,” “English-Platinum Member-Account Inquiry.” Ensure the greetings your agents record are 
generic enough to cover the range of customer calls they handle.

http://docwiki.cisco.com/wiki/Troubleshooting_Unified_CCE
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How to Deploy and Configure Whisper 
Announcement

This chapter describes how to deploy and configure the Whisper Announcement feature in a 
non-Parent/Child deployment. To deploy and configure Whisper Announcement in a Parent/Child 
deployment, see Chapter 11, “Whisper Announcement in a Parent/Child Deployment.”

Whisper Announcement Deployment Map
This is the high-level sequence of tasks you need to complete to deploy Whisper Announcement. 
Individual steps are covered in more detail in later sections.

1. Ensure your deployment meets the baseline requirements for software, hardware, and configuration 
described in the System Requirements and Limitations section. See System Requirements and 
Functional Limitations, page 8-1.

2. Create a Whisper Announcement audio file for each different whisper to play. See Creating Whisper 
Announcement Audio Files, page 10-1.

3. Deploy your Whisper Announcement audio files to your CVP media server. See Deploying Whisper 
Announcement Audio Files to the Media Server, page 10-2.

4. Ensure that the Whisper Service Dialed Number (91919100) is covered by your dial plan. See 
Configuring the Whisper Service Dialed Numbers, page 10-2.

5. In the Unified CCE Script Editor tool, create (or modify existing) call routing scripts to include 
Whisper Announcement. See Whisper Announcement Sample Scripts, page 10-11.

Creating Whisper Announcement Audio Files
You must create audio files for each different Whisper Announcement to use on your system. For 
example, “Sales, English” or “Soporte Técnico en Español.” Create the files using the recording tool of 
your choice.

When recording your files:

• The media files must be in .wav format. Your .wav files must match CVP encoding and format 
requirements (G.711, CCITT A-Law 8 kHz, 8 bit, mono). 

• To avoid clipping of files when they are played, make sure they do not exceed the Whisper 
Announcement play limit (15 seconds, by default). 
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• Test your audio files. Ensure that they are not clipped and that they are consistent in volume and 
tone. 

• To reduce the likelihood of scripting errors, decide ahead of time on a file naming convention that 
is easy for you and others to remember. For example, en_sales.wav, sp_support.wav. 

• Note the names of each file and the location where you deploy them on the CVP media server. Script 
authors need this information for call routing scripts.

Deploying Whisper Announcement Audio Files to the Media Server
Deploy your whisper audio files to your CVP media server using whatever file transfer method you 
prefer. The most important consideration is where on the server to place the files. HTTP requests for 
media server audio files are constructed as 
“http://<media_server>/<locale_directory>/<application_directory>/<file_name>.” The CVP defaults 
for the locale and application directories are “en-us/app.” Knowing this, Unified CCE automatically adds 
“en-us/app” to the server name when making HTTP requests for media files. For example:

• If the script node that defines the media server has a value of “http://myserver.mydomain.com” 
and... 

• The script node that defines the audio file to play has a value of “en_sales.wav,” then... 

• The HTTP request for the file is automatically constructed as 

http://myserver.mydomain.com/en-us/app/en_sales.wav

To store your files in a different locale and application directory, your routing scripts must include 
variable nodes that define those alternate locations.

Make note of the directories where you place your files and communicate the locations to your script 
authors. Again, deciding ahead of time on a filing and directory naming convention that is easy for you 
and others to remember can reduce the likelihood of scripting errors. And always make sure that the 
directories where you deploy your files have the appropriate permissions to allow Read access.

Using a Default Media Server

Optionally, CVP lets you define a default media server. (You do this in the CVP Operations Console; see 
your CVP documentation for more information.) If a default media server is defined in CVP, script 
authors need not identify the media server in their call routing scripts provided the files that they request 
are available from that server.

Configuring the Whisper Service Dialed Numbers
For Whisper Announcement, CVP uses two different dialed numbers when transferring a call to an 
agent:

• The first number calls the ring tone service that the caller hears while the whisper plays to the agent. 
The CVP default for this number is 91919191. 

• The second number calls the whisper itself. The CVP default for this number is 9191919100.

For Whisper Announcement to work, your dial plan must cover both of these numbers. The easiest way 
to ensure coverage is through the use of wild cards such as 9191*. However, if you decide to use an exact 
dialed number match then you must specify both 91919191 and 9191919100.
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Where to Configure the Dialed Numbers

You configure the dialed numbers for Whisper Announcement in the CVP Operations Console at 
System > Dialed Number Pattern > Add new. For the Dialed Number Pattern Types, select Enable Local 
Static Route, and then deploy the dialed number to your VXML gateways. If necessary, you can override 
a dialed number plan at the SIP subsystem level.

If CVP uses a SIP proxy server, and all outbound calls are routed to the proxy, you must configure the 
Whisper Announcement dialed numbers in the static routes section of the CUP or CUSP proxy.

Dialed Number in the Dial-Peer

In addition to configuring the dial plan in CVP, examine your IOS dial-peer. Make sure that the dialed 
number setting in your dial-peer configuration accommodates both of the whisper service dialed 
numbers.

Adding Whisper Announcement to Your Routing Scripts

The most important piece in deploying Whisper Announcement is to include the requisite variables and 
settings in your Unified CCE routing scripts.

Variables for Whisper Announcement

To play a Whisper Announcement, you must include at least one, and possibly more, of these call 
variables in your routing scripts:

Always Needed

WhisperAnnouncement Call Variable: This variable is required to play a Whisper Announcement and 
performs the following functions:

• By its presence in the script, it causes a Whisper Announcement to play 

• Through its value, it specifies the name of the audio file to play for the announcement.
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You must set the WhisperAnnouncement call variable before the script node that queues the call to an 
agent (that is, the Queue [to Skill Group], Queue Agent, Route Select, or Select node).

Possibly Needed

You may also need to include in your scripts, Set Variable nodes that:

1. Specify the Whisper Announcement Media Server: CVP lets you specify a default media server. 
If you are not serving your whisper files from the default media server, your scripts must include a 
variable that identifies the server where your audio files are stored.

2. Set the Path to Your Audio Files: Additionally, you may need to include these variables to define 
the location of your Whisper Announcement files: 

– If you do not store your whisper files in the default locale directory (“en-us”) on the media 
server, you must include a variable that specifies the name of the locale directory where the files 
are stored. 

– If you do not store your whisper files in the default application directory (“app”) on the media 
server, you must include a variable that specifies the name of the application directory where 
the files are stored.

Specifying the WhisperAnnouncement Call Variable

To include Whisper Announcement in a script, insert a Set Variable node that references the 
WhisperAnnouncement call variable. The WhisperAnnouncement variable causes a whisper to play and 
specifies the audio file it should use. Typically, you use a single whisper prompt throughout a single call 
type. As a result, you use only one WhisperAnnouncement set node per script. However, as needed, you 
can set the variable at multiple places in your scripts to allow different announcements to play for 
different end points. For example, if you do skills-based routing you can specify the variable at each 
decision point used to select a particular skill group.

Note Only one Whisper Announcement can play per call. If a script references and sets the 
WhisperAnnouncement variable more than once in a single path through a script, the last value to be set 
is the one that plays.

Use these settings in the Set Variable node for Whisper Announcement:

• Object Type: Call. 

• Variable: Must use the WhisperAnnouncement variable. 

• Value: Specify the file name of the whisper file. For example: “my_whisper.wav” or “my_whisper.”

– Specify the file name only, not its path. 

– You must enclose the file name in quotes. 

– The file name is not case-sensitive. 

– The file name cannot include spaces or characters that require URL encoding. 

– Including the .wav extension is optional. If you omit it, CVP adds it automatically in the HTTP 
request.
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Specifying the Media Server

You can define a default media server in your CVP Operations Console. If you do this, and if that is the 
server from which you serve you whisper files, then you need not specify the media server in your 
routing scripts. However, if you do not define a default media server, or store your whisper file on a 
server other than the default, then your scripts must include a Set Variable node that identifies that server.

Use these settings in the Set Variable node to specify your media server:

• Object Type: Call.

• Variable: Must use the user.microapp.media_server ECC variable. 

• Value: Specify the HTTP path to the server. For example: “http://myserver.mydomain.net” You must 
enclose the path in quotes. 

• Alternately you can specify an IP address in place of a DNS. Include the listening port number if the 
media server web server listens on a port other than 80 (for HTTP) or 443 (for HTTPS).
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Specifying the Whisper File Locale and Application Directories

CVP uses a default storage directory for media files: <web_server_root>/en-us/app. To take advantage 
of this, Unified CCE call routing scripts automatically add “en-us/app” to the server name when 
constructing HTTP requests for media files. For example:

• If the script node that defines the media server has a value of “http://myserver.mydomain.com” 
and... 

• The script node that defines which audio file to play has a value of “en_sales.wav,” then... 

• The HTTP request for the file is automatically constructed as 

http://myserver.mydomain.com/en-us/app/en_sales.wav

If your whisper audio files are stored in a different locale directory, you must add a Set Variable node to 
your script that identifies the locale directory. Similarly, if your whisper files are stored in a different 
application directory, you must add a Set Variable node that identifies that directory.

Specifying the Locale Directory

Use these settings in the Set Variable node to specify your locale directory:

• Object Type: Call.

• Variable: Must use the user.microapp.locale ECC variable. 

• Value: Specify the directory name. For example: "pt-br" You must enclose the path in quotes.
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Specifying the Application Directory

Use these settings in the Set Variable node to specify your application directory:

• Object Type: Call. 

• Variable: Must use the user.microapp.app_media_lib ECC variable. 

• Value: Specify the directory name. For example: to use a directory "wav_files" in place of the default 
directory "app" enter "wav_files." To use a sub-directory "wav_files" "app" enter "app/wav_files." You 
must enclose the path in quotes.
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Variable Length for Media Server, Locale, and Application Directory Variables

If you do include Set Variable nodes for the media server, locale, or application directories, ensure that 
the values you set for them do not exceed the Maximum Length settings for their corresponding ECC 
variables.

For example, if you include a Set Variable node for the media server with a value of 
"http://mysubdomain.mydomain.co.uk," the string is 33 characters long. Therefore, the Maximum 
Length setting for the user.microapp.media_server ECC variable must be 33 or greater. If it is not, you 
must increase the Maximum Length setting. Otherwise the server name is truncated in the HTTP request 
for the file and the file is not found. You configure ECC variables in the Unified CCE Configuration 
Manager at List Tools > Expanded Call Variables List.

Other Script Settings Required for Whisper Announcement

These further settings are required for Whisper Announcement to work:

1. Enable Target Requery on all script nodes that follow the WhisperAnnouncement variable and target 
an agent. These include Queue (to Skill Group), Queue Agent. Route Select, and Select. If Target 
Requery is not enabled, the Whisper Announcement does not play.

2. Use a SendtoVRU or TranslationRouteToVRU, or a Run Script Request node, before targeting an 
agent when running an agent transfer or conference script.

Testing Your Whisper Announcement File Path

To test the path you defined to the whisper file in you script variables, plug the complete URL into a 
browser. The wave file should play. For example:

• If your script includes: default media server + default locale + default application directory + 
whisper.wav, then the path should be "http://<default_media_server>/en-us/app/whisper.wav" 

• If your script includes: "http://my_server.my_domain.com + default locale + "app/wav_files" + 
whisper.wav, then the path should be 
"http://my_server.my_domain.com/en-us/app/wav_files/whisper.wav"
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Configuring Whisper Announcement Play Length
This section contains information about configuration options that you can use to tune Whisper 
Announcement.

Option Description Default Value

Whisper Announcement 
Timeout 

The maximum play time for a Whisper 
Announcement. Whisper Announcements 
that exceed the maximum play time are cut 
off. 

15 seconds

When or Why Would you Change It ?

The most likely scenario is to raise the timeout because whisper 
files are cut off before they finish playing. 

Make sure your timeout value is coordinated with the play length 
of your Whisper Announcement files to avoid clipping. If you 
modify this timeout, you may need to modify the Whisper 
Announcement fail-safe timeout as well. 

How to Change It

On the CVP VXML Gateway, in IOS, set the ring tone service 
whisper-timeout parameter to the new value: 

1. On your CVP VXML Gateway, open a command prompt, 
login to IOS and enter config mode (conf t).

2. Edit your application as follows: my_server(config)# 
application my_server9(config-app)# service ringtone 
my_server(config-app-param)# param whisper-timeout 
<value_in_seconds>. 

3. Return to the enable prompt and apply your change by 
reloading the ringtone service as follows: my_server# call 
application voice load ringtone.

4. Repeat this process on all CVP VXML gateways that deliver 
Whisper Announcement. 
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Fail-safe timeout for Whisper 
Announcement in Unified CCE

CVP sends one message to Unified CCE 
each time a Whisper Announcement begins, 
and a second message when the 
announcement ends. The time stamps from 
these messages are used to calculate 
Whisper Announcement data in Unified 
CCE reports. 

In the rare event that CVP fails to send a 
Whisper Announcement end message to 
Unified CCE (due to a CVP crash, for 
example), the following would occur: 

• Unified CCE cannot accurately 
calculate the whisper length, thus 
skewing report data. 

• The agent cannot control the call (for 
example, put it on hold or transfer it) 
because these controls are disabled 
while a Whisper Announcement is 
playing. To prevent this, Unified CCE 
has its own Whisper Announcement 
timeout setting. The value for this 
setting represents the maximum 
Whisper Announcement play time that 
Unified CCE uses to calculate its report 
data.

20 seconds. This 
default is based 
upon the default 
Whisper 
Announcement play 
time (specified in 
CVP) of 15 
seconds). The extra 
five seconds in the 
Unified CCE 
fail-safe timeout are 
a buffer against 
latency.

When or Why Would you Change It ?

If you modify the maximum Whisper Announcement play time in 
CVP, you should modify the Unified CCE Whisper 
Announcement fail-safe timeout accordingly. 

The Unified CCE Whisper Announcement fail-safe timeout value 
should always be equal to or (preferably) greater than the maximum 
Whisper Announcement play time setting in CVP. Otherwise 
Whisper Announcement play time in Unified CCE reports are grossly 
under-reported.  

How to Change It

Where:

Unified CCE Configuration Tools > PG Explorer > Peripheral 
(tab) > Configuration Parameters (field).

Format: 

String: /WHSTMOUT <value in seconds> 

Example: 

/WHSTMOUT 20 

Option Description Default Value
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Whisper Announcement Sample Scripts
ICME includes sample routing scripts that demonstrate Whisper Announcement. You can use them as 
learning tools and as models for your own Whisper Announcement scripts. They include:

• WA.ICMS This script plays a Whisper Announcement. 

• WA_AG.ICMS This script plays both a Whisper Announcement and an Agent Greeting to play on 
the same call flow.

The script files are located in the icm\bin directory. On Internet Script Editor they are installed to the 
application root directory.

Note Both of these sample scripts assume that a default media server is configured in CVP, and the Whisper 
file is stored in the default location on the media server. For that reason, they do not include variables 
that specify the media server, locale, or application directories.

About the WA.ICMS Script

This script sets up a Whisper Announcement by setting the Whisper Announcement variable to the 
desired wav file and then queuing the call to a skill group. Once an agent is selected from the skill group 
and the call routed to the agent, the whisper plays to the agent.
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About the WA_AG.ICMS Script

This script causes both a Whisper Announcement and an Agent Greeting to play.

How to the Import the Sample Whisper Announcement Scripts

To view or use the sample Whisper Announcement scripts, you must first import them into Unified CCE 
Script Editor. To import the scripts:

1. Launch Script Editor.

2. Select File > Import Script and select the first of the two scripts to import.

3. In addition to importing the script, Script Editor tries to map imported objects. Some objects 
referenced in the sample scripts, such as the external Network VRU scripts or the skill groups, do 
not map successfully. You must create these manually or change these references to point to existing 
scripts and skill groups in your system.

4. Repeat these steps for the remaining scripts.
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Whisper Announcement in a Parent/Child 
Deployment

To use Whisper Announcement in a parent-child deployment, you must configure it on a system PG 
using Cisco Unified Contact Center Express (CCX). Unified CCX (IP-IVR) is required on the child 
where call queuing occurs.

Note Whisper Announcement for Parent/Child is only supported for a very specific Parent/Child 
configuration. Whisper Announcement in Parent/Child configurations must be approved by the Cisco 
Assessment to Quality (A2Q) process and require Cisco Design Mentoring Service to assure that the 
deployment model is designed and sized correctly to support the Whisper Announcement feature.

Within a child, Whisper Announcement plays for:

• incoming calls not initiated by an agent on the same child. 

• single-step and blind consultative transfers to an agent on the same PG where the call is queued 
before the call is answered.

Note Blind consultative transfer is where the transferring agent completes the transfer before the 
consulted agent answers.

• inbound and transfers/conferences to an agent on a different child.

Whisper Announcement always plays to an agent when a call originates from outside the Cisco Unified 
Call Manager that answers the call. The same behavior occurs when the call is transferred or conferenced 
and the transfer or conference initiator is not registered to the same Cisco UCM that answers the call. 
For all other scenarios, Whisper Announcement does not play. Some businesses may choose to disable 
Whisper Announcement in all transfers for consistency purposes (the feature is controlled through 
scripting).

If a caller hangs up on an incoming call while whisper announcement plays to an agent, a three second 
delay occurs before the cleared call is reported and the agent desktop is updated. The purpose of this 
delay is to distinguish between an abandoned call or just the completion of the whisper announcement.

If an agent hangs up the hard phone while whisper announcement plays, the incoming call is routed to 
the phone of that agent and the call is auto-answered.

Whisper announcement in a parent-child deployment is supported with both local and mobile agents.
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Note Peripheral call variables are not preserved by the system PG after a call is sent to Post Route Trigger.

Functional Limitations
Whisper Announcement (in a Parent-Child deployment) is subject to the following limitations:

• A call must be sent to Unified CCX before the call is sent to the targeted agent, regardless if the call 
requires queueing.

• Calls that are routed to an agent using the Label node are not supported.

• Calls that originate from one System PG when the targeted agent is on a different System PG on the 
same child are not supported.

How to configure Whisper Announcement in a Parent-Child Deployment
To configure Whisper Announcement in a parent-child deployment, you must complete the following 
tasks:

1. Configure two ECC variables for user.whisper and user.media.id. See How to Configure the 
user.whisper and user.media.id ECC Variables, page 11-2.

Note Configure the user.media.id on the child, not the parent.

2. Enable Agent Whisper. See How to Enable Whisper Announcement, page 11-3.

3. Configure the routing script. See How to Configure the Routing Script, page 11-4.

4. Upload the whisper prompt .wav file. See How to Upload the Whisper Prompt .wav File, page 11-5.

5. Configure the ring tone for Network Audio Source. See How to Upload the Ringtone, page 11-6 and 
How to Configure Network Hold Audio Source, page 11-7.

6. Configure the timeout for Whisper Announcements. See How to configure timeout for Whisper 
Announcement, page 11-8.

Prerequisites

• Configure CTI Ports.

• Ensure that IP-IVR is working with ICM.

• Ensure that IP-IVR can queue the call for ICM. 

• Configure a “Send to VRU” node.

How to Configure the user.whisper and user.media.id ECC Variables

Complete the following procedure to configure the user.whisper and user.media.id ECC variables.

Note Configure the user.media.id variable on the child, not the parent.
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Prerequisites

The details of the user.whisper ECC variable are as follows:

• Name: user.whisper 

• Datatype: 40 character string

The details of the user.media.id ECC variable are as follows:

• Name: user.media.id 

• Datatype: 40 character string

Steps

Step 1 Log into Cisco Unified Contact Center Enterprise.

Step 2 Click Start > All Programs > Cisco Unified CCE Tools > Administration Tools > Configuration Manager.

Step 3 In Configuration Manager, expand Tools.

Step 4 Double Click Expanded Call Variable List.

Step 5 In the name box, type the name of the variable.

Step 6 In ECC variable attributes, check the enabled box.

Note The user.whisper and user.media.id ECC variable names are case sensitive.

How to Enable Whisper Announcement

Complete the following steps to enable Whisper Announcement.

Steps

Step 1 Launch Cisco Unified CCX Administration.

Step 2 In the Username box, type your username.

Step 3 In the Password box, type your password.

Step 4 Click Login.

Step 5 From the menu, select Subsystem > ICM > General. The ICM configuration page appears.
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Step 6 In the Additional VRU call information section, check the Media ID and Whisper Announcement check 
boxes.

Step 7 Click Update.

How to Configure the Routing Script

Complete the following steps to configure the routing script.

Before You Begin

• Configure the ECC variables. 

• Ensure that a Routing Script is created and uploaded.

Steps

Step 1 Log into UCCE.

Step 2 Select Start > All Programs > Cisco Unified CCE Tools > Administration Tools > Script Editor.

Step 3 Select the routing script to modify.

Step 4 In the routing script, add a Set Variable node.

Use these settings in the Set Variable node:

• Object Type: Call

• Variable: Use the user.whisper ECC variable.

• Value: Specify the directory name of whisper file. For example: “wav_files”

To use a sub-directory “wav_files” in “app,” enter “app/wav_files.” You must enclose the path in quotes.

Step 5 Set user.whisper to whisper prompt file name, for example “whisper.wav.”

Step 6 Before the Queue node, add a Send to VRU node.
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Step 7 Click Update.

Sample Script

How to Upload the Whisper Prompt .wav File

Note The length of Whisper Announcement prompt file should be less than the maximum configurable 
Whisper Announcement timeout value. If the length of Whisper Announcement prompt file exceeds the 
maximum Whisper Announcement configurable timeout value, when Whisper announcement times out, 
the incoming call is redirected to agent and the call is auto-answered.

Before You Begin

• Configure the ECC variables. 

• Enable Agent Whisper. 

• Configure the routing script.

Steps

Step 1 In Cisco Unified CCX Administration, choose Applications > Prompt Management.

Step 2 Click Upload Prompts. The Upload Prompt Window appears.

Step 3 In the File Name box, type the name of the .wav file OR click Browse to browse to the file location.
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Step 4 Click Upload.

How to Upload the Ringtone

Configure the ring tone to be played to the caller when Whisper Announcement is played to the agent.

Steps

Step 1 Launch the Cisco Unified CM Console.

Step 2 In the Username box, type your username.

Step 3 In the Password box, type your password.

Step 4 From the menu, choose Media Resources > MOH Audio File Management.

Step 5 Check the .wav file to upload.

Step 6 Click Upload File. The Upload File Window appears.

Step 7 In the Upload File box, type the file name OR click Browse to browse to the file location.
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Step 8 Click Upload.

How to Configure Network Hold Audio Source

Complete the following steps to configure the Network Hold Audio source.

Before you begin

• Configure and upload a ringtone. 

• Configure a Call Control Group. 

• Upload the ringtone .wav file.

Steps

Step 1 In Cisco Unified CCX Administration, from the menu, select Subsystems > Cisco Unified CM 
Telephony > Call Control Group. The Cisco Unified CM Telephony Call Control Group Configuration 
page appears.

Step 2 Select the CTI Port to modify.

Step 3 From the Network Hold Audio Source list, choose the ringtone media source. If the Network Hold Audio 
list does not appear in the window, click Show More.
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Step 4 Click Update.

How to configure timeout for Whisper Announcement

Complete the following steps to configure the timeout length for Whisper Announcements.

Steps

Step 1 Log into UCCE.

Step 2 Select Start > All Programs > Cisco Unified CCE Tools > PG Explorer > Peripheral(tab) > Configuration 
Parameters (field).

Step 3 Click the Peripheral tab.

Step 4 In the Configuration Parameters box, type /WHSTMOUT <n> where <n> is the time in seconds.

For example, /WHSTMOUT 20. The default value is 20.
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Related Information

See the following sources for additional information:

• For information about phone compatibility, see the Unified CCE compatibility documentation.

• For information about how to configure your CVP media server, VXML gateway, Call Server, ECC 
variables, SIP subsystem, and how to create Network VRU scripts for CVP micro-apps, see the CVP 
8.5(1) documentation.

• For load performance and sizing information, see the Unified CCE SRND Guide.

• For troubleshooting information, see the Cisco DocWiki.

Related Information for Agent Greeting
See the following sources for additional information related to Agent Greeting:

• For information about how to include Agent Greeting controls on your agent desktop, see the 
CTI OS Developer’s Guide.

• For information about Mobile Agent with Agent Greeting, see the Mobile Agent Guide for Unified 
CCE.

• For information about how to configure Translation Routes, see the ICM configuration guide.

http://www.cisco.com/en/US/products/sw/custcosw/ps1844/products_installation_and_configuration_guides_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1844/products_device_support_tables_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps14/products_programming_reference_guides_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1844/products_user_guide_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1844/products_user_guide_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1844/products_implementation_design_guides_list.html
http://docwiki.cisco.com/wiki/Main_Page
http://www.cisco.com/en/US/products/sw/custcosw/ps1006/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1006/tsd_products_support_series_home.html
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